Nebraska Admissions Application

User Guide

Note: The application will work on multiple different types of browsers, but it has been optimized to
work in Google Chrome. To download Google Chrome use this link:
https://www.google.com/chrome/browser/desktop/index.html

Note: Because of the large volume of data associated with an application, a few screens may take longer
than normal to load. The screens loading the most data are the Application Overview screen and the
Edit Prior Applications screen. Please pay attention to your progress indicator in your browser. In
Chrome when a page is loading you will see a circle spinner icon. When the page is done loading the
circle will stop spinning and disappear. Please be patient and wait for the page to finish loading before
you attempt to click on anything else.
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1. Recurring Themes

There are a few recurring themes throughout the application that appear on multiple pages.

1.1. Error Handling

Errors within a popup will be display in red at the top of a popup in a numbered list as displayed below.

Please correct following efrors:

1. From Date cannot ibe bank

2. From Date must fonmatied as mmdbyy
3 Adiess 1 cannol b plank

AddressP.0. Box

County
From Ta Leave blank for current address

if 3 or more months 81 this address, complate the slormaton far bbeal law anforcement

Local
Law
Enforcement

i
| Save Cancel




Errors on a main page will either display at the top of the screen as show below,

1e Court Attorney Services Division

» You dflempled (o access a page for an appication you don't have access o —

Applications
Ta bagln an application now salect the button balow.

Bagn New Appication My ACcount

1000 QRZATNT Hoi Submilied

Centnue
1001 Class 148 QB2BNT OB22017 Submitied Visw
1002 Class 14 OBZREHT OB02017 Submitied View
1003 QB2 T OB312017 Submitted View
1004 Exam Applicant OE3MENT OBSNZ01T Submitied View
1005 Class 1A QeBEn T et Submitied Continue

Or be shown directly under the field that contains the error with detail about the error.

Address Type = Readence Busness

Applicant Type

Category Class 14 I
NCBE Number
MPRE Score

Exam Date

Prior Jurizdiction



1.2. Button Placement

When you get into the detail screens for specific sections, both the Back to Overview button and Save
Changes button will be located on the top right as shown below. Make sure after making changes you
scroll back up to the top if necessary to hit Save Changes or else your changes will not be saved.

Add buttons will be at the top right of a table.

Residence Information Application: 1025

Hack to Owerview | Save Changes h

List ewery parmanant ar temporary physical address where you have resided for a peniod of ona more o longer in reversa chronalogical ordes
» Il you have submitted an application Tor bar admession or 1o pre-register as a law student with a bar admitling authority, or have been admitled, kcensed, or
aulhonzed 1o practce law, provide your residency information for the last ten years or since you wera first admitted, licensed, or authonzed to practice law,
whichever period of time Is longer.
« [f the previous category does not apply to you, provide your residency information for the last fen years or since age 158, whichever period of time is
longer.

Addresses 4 < —

333 My Streed, Anytown, NE, 55555 MyCounty 02 0505 ik



On a popup, the Save button and Cancel button will be on the bottom right. Make sure you select Save
once you are done entering your data. If you wish to cancel and not make any changes, select the Cancel
button.

AddressiP.O. BOX on 1y sy

Anytawn
countny
County MyCounty
From oo To ofos Leave blank for currer address

if 3 ar more months a1 this address, complete the nformation for ical law enforcement
Local

Law
Enforcemeant L44 Polica Ln

Arytown Police

e
Anytown
Eauniny

lawDemal com




1.3. Edit and Delete Icons Inside a Table

When you have the ability to edit and delete specific information, you will see the Edit and Delete icons
on the far right of each table row.

Addresses El

333 My Street, Anylown, NE. 55555 My County oo 05405 £ X P

Once you hit the Edit icon, a popup will appear with the information for the selected row pre-filled.
Make any changes necessary and hit Save, or hit Cancel if you don’t wish to make any changes.

AddressiP.O. BoX oy 4 s

County nyCounty
From oo To 0505 Leave blank kv curen addrass

If 3 ar moee months o This address, complebs the mformabon for kocal law enforcemen

Local
Law
Enforcemant 144 Police Ln

Amytown Police

v 55555
oLy

lEras@emal com




If you hit the Delete icon, you will see a popup appear asking if you are sure you want to delete the
record. Hit Delete to delete the row, and Cancel if you wish to keep it.

Arg you sure you want fo delete 333 My Streel, Anytown, NE, 555557

Delete Cancel




1.4. Navigation Menu

Navigation related to the Admissions application will be on the top left of the screen. You can select
Home, or under the View menu you will have the following options

o Applications —see a list of your existing applications and have the ability to create a new
application

e Exams —view any available exam scores

e Payments —view any payments that have been made — if you have just made a payment, it may
take a few minutes for a payment to show up on this list

e User Guide —view this guide

Nebraska Supreme Court Attorney Servic

Admissions Hoime

Appi alions

Exams m —

Paymenis

User Guids To bEgi.I'l an appll:a:mn now

Begin Mew Applcation | My Ac



On the top right you will see menu options relating to your user account. Your name will display with a
menu option, if you hover over you will see the options for the following:

e Edit Account —these changes will be relating to your login account, such as username, email,
etc. This will NOT update any of your information already saved to any application(s).
e Change Password — update your existing password

Also on the top right you will see an option to Logout.

Admissions me

Application: 1025

+ Ganaral

+ Pricr Applications for Admission

» Egucation

+ Residences ana Local Law Enforcement
+ Employmaet

+ Character and Faness

* Chvil | Crimsinal | Traffic

+ Financial Hissory

+ Character Reterences

Edil Account

Change Fassword



2. Getting Started

2.1. Login Page

When you first come to the Admissions application, you will be sent to the login page. From here enter
your username and password and select the Login button. If you have forgot your password, select the
Forgot Password link. If you need to view the User Guide, select the User Guide link. If this is the first
time visiting the application, you will need to select the Create Account button to create a new account
to be able to navigate the system.

Sign in

reabe Account



2.2. Create Account

Once you have selected the Create Account button from the Login page, you will come to the Create
Account screen. Enter the information on the screen. At the bottom of the screen you will need to click
the captcha to make sure you are not a robot. Occasionally you will just need to select the checkbox,
sometimes you will also need to follow the instructions and click on some pictures before you proceed.
Once you have entered all your information select Create Account. If you remain on the same screen,
that indicates there are some errors with your entry, either the wrong format of an entry or you have
not filled out a required field. Correct these errors and try again.

Create Account
Username
Password
Confirm Password
Security Question
Security Answer
Contact Information
Email
Caonfirm Email
Home/Mobile Work

Address

Address Type  Residence Business

Narme

Gender O Male Female
Date of Birth

Place of Birth

Citizenship

Social Security Number

Applicant Type . Exam Matian

™
é I'rr paat & robot
Cregte AcTount —



3. Creating an Application or Editing an Existing Application

3.1 Application List Page

Once you have logged on, successfully created an account, or select View -> Applications from the
menu, you will be sent to the application list page. This page contains a list of any existing applications
you have created. It will provide basic information about the application as well as an action button for
each application. The possible actions are the following:

o If you have started work on an application but not completed it, you will see a Continue button

o If you have finished work on an application and an administrator has indicated that payment
information is needed, you will still see a Continue button but it will take you to the Calculate
Payment page

e If an application has been marked as complete by an administrator, you will see a Print button.

Applications

To begin an application now select the button balow.

Begin hew Apphcalicon Ky ACcown!

1oz ez Mot Submitied Continue ?



3.2 Directions and Preamble

Before starting to work on an application, you will see a page with directions where you will need to hit
a Continue button to move to the next screen. After that you will be taken to the preamble page where
you will need to indicate that you have read the above and select the Continue button.

Directions

Read the Nebraska Admission Reguirements for the practice ©f law onling hene

Angwer all questions in full. Complete all farms &5 appicable. Your applcation will be processed only after you have submitied payment, the application, Singerprints, notarized releases
and afdaviis, and any other supplemental documents required by responses o specific questions (2.9, if you are admitted in another junsdiction, you must submA a Certificate in Good
Standing)

+ Applic ations will not be processed untl all required documentation has been recefved

- Inaccurale, incomplete, of INCIEAr responses 10 questions will delay your application

+ Provide your Tull legal name and all previpusly used names. Your nameqs) will be used for identification for references

= Provide the curment number. stresl name, cfy, slate. Zip cooe. and email aodress whens requested

+ It is the applicant’s responsibality o provide accurate contact infarmation for all former employers, personal and academic references, and for law enforcement agencies.
» Inform references, curnend and former emplayers. that they will be contacied

+ Keep & copy of your application and all supplemental documents. for your Feconss

» Subsequent or Concurment appications — Repon il subsequentconcument appiications to state, foresgn, and tribal jurisections (35 desonbed in question &) thal ane submitied
while this application is pending

= It & your responsibility (o update your appacation unil you have been notMed that your appication is approved or denied. Amendment and revision fonms may be found hene
= You will be notified it aoditicnal infonmation B needed fof your applicalicn. SLalus upaass ane nol provided on applic ations.

Any questions reganding this appication or the bar exam, must be made in wniing oo nsc attyadmissions@Enetraska. gow

Continge ?

Preamble

The Mebraska Supreme Courl (Courf) exercises junsdiclion over admission 1o the pracice of law in the Stabe of Nebraska. The Court estabished the Nebraska State Bar Commission
(Commissaon) 10 review all appiicanis and make recommendations to e Coun for admission, See Ned. O R §3-100

The Coammission is charged with conducting an invesigation inbo each applikant's moral character and fitness o practice law. The objective of characier and fness screening s to
profect ihe public and safeguard the iegal system. The purpose of Nguines inlo e applicant’s background is 10 produce information Necessany to svaluale the apphcant’s characher and
finess. S2e Neb, CL R, §3-116

It = the applicant’s responsibdity to provide information as requesied by the Commission 1o demaensirabe the applcani meets the requirements for the praciice of B as sef forth by the
Mebraska Supreme Cowrl. See Nab, CL R, §31235

The Commission conducts a thorough and extensive background investigation. Falure to disciose relevant information will have senous consequences. Information gathered in the
course of the imvestigation is for the imited purpose of determining an applicant's eligibdity o practice law and is subject ta nukes of confidentzality Sl farth by the Mebraska Supreme
Coun, See Neb. C1. R §3-127

ﬁ 11 have read the above.
Conginis %



3.3 Application Overview Screen

The application overview screen will allow you view all the information you have saved for the current
application. The application ID will be indicated on the top right. You can only view one section at a
time, and you can expand a different section by clicking on the section header. The selected section will
have the header color change to blue.

3.3.1 General Section

To edit the current section click on the Edit button on the top right.

Application: 1025 <«(mmmm—m——

= ?

Name Tesi User
Gender Feerraie
Date of Binh  0Q/01/1930
Place of Birth
Citizenship

SEN

Contact information

Ermai testemati@email.com
Phane 1 Phone 2
Address 123 Test 5t Anvtown, NE, 55555

Address Type Resicenial

Applicant Type

Catwgoury
HCBE Number MPRE Score  Exam Date

Frier Jurisdiction

Former Names

¢ Prior Applications for Admission

v Education

+ Residences and Local Law Enforcement
+ Employment

+ Character and Friness

+ Civil | Criminal [ Traffic

¢ Financial History



3.3.1.1. Edit General Information Screen

You can edit information on this screen. The list of Former Names will display at the bottom. If you need
to add to this list, click on the Add button on the top right of the table. If row(s) exist, and you want to
edit or delete the row, use the edit and delete icons. Make sure if you need to edit information on this
screen you select the Save Changes button on the top right. To go back to the overview select the Back
to Overview button.

General Information Application; 1025

Backto Cverview | Save Changes
Name .., Usar

Gender O Male ® Famale
Date of Birth ;11990

Place of Birth ¢ bkt .
Citizenship __ .
Social Security Number .

Contact Information

Emall o emangemat com

Confirm Email lesiemakZemad com

Home/Mobile hid Work

Address 0. s s

Aryioam Mebraska L=
coumny

Address Type » Readence Business

Applicant Type
Category .,
NCEE Number N

MPRE Score ..

Exam Date

Prior Jurisdiction

Lit badowy all the ofher names oF sumames you have used or bean known by, and describe whan, how, and why your name was changed (9., mamage of
divorce)

Former Names Add h



3.3.1.1.1. Former Name Popup

If you have selected the Add button on the Former Names table or chosen to edit an existing row, you
will see the Add Former Name Popup. Enter any necessary information and hit the Save button. Hit the
Cancel button to close the popup without saving. You can also click anywhere outside the popup to
close the popup without saving.

Save Cancel

Once you hit the Save button the popup will close and the new row will show up in the table.

Prior Jurisdiction

Lisl bakow all the olher names or surmnames you have used or been known by, and describe when, how, and why your name was changed (e g, marriage or
divorce)

Former Names [ mj

Test Userlid o1eh o208 Mame change duse bo mamiage s



If you hit the Edit icon for an existing row, you will see the Edit Former Name popup with the row data
prefilled. Change any information you need to and hit Save or hit Cancel to close the popup without
saving.

Name  Test middiE nams

Dates From: 01e0 To: 0206

Reason MNamec hange dug o mamage

Sive Cancel

If you hit the Delete icon for an existing row, you will get the Delete Record popup. You will need to
confirm that you want to delete the row. Hit Delete to delete the row and Cancel to close the popup and
keep the record.

Are you sure you want o delete Test UserOld?




3.3.1.2. General Section — Completed

Application; 1005

Hame Test Userd

Gender Female

Date of Birth DB/242077

Place of Birth X1 Man 51 Rasegh, NC, USA 36104
CHizenship  Uniled States

55N 123456780

Contact Information

Email a@a.com
Fhone 1 (503) 123-4867 Phonm 2 (212} 123-4567
Address £23 Main St test. Rapd Cily, 3D, USA 36104

Address Type Hesidantial

Applicant Type
Category Class 1A
NCEE Humber MPRE Score  Exam Date 1115

Prior Jurisdiction dddddoddddddaddoddidddddasddaddiddoddoddadd

Former Names

Eait

* Prier Applications for Admi

* Education

* Residences and Local Law Enforcement
* Employment

*» Character and Fitnass

= Civil J Criminal | Traffic

+ Financial History



3.3.2. Prior Applications for Admission Section

To edit the section click on the Edit button on the top right.

Application: 1025

Prior Applications For Admission B ?

Prior Applications Fer Admissions and Authonzations To Practce Law
Have you ever submitted an apphication to register as a law student?

Hawve you ever applied for admission on motion?

Hawve you ever applied for admission on motion by transterred UBE score?
Have you ever appiied for admission by diploma privilege?

Have you ever registered as a foreign legal consultant?

Have yau ever reg a3 fp-house e ?

Have you submitied any other applications 7

Bar Association Membership

Amorney Conduct

Have you ever been disbarred, censured, reprimanded, or disqualified as an attomey?
Have you ever been the subject of any charges, complaints, o gri I ing your
conduct as an attormey?

Have you ever been the subject of any charges, complaints, or grievances alleging that you
sngaged in the unauthonoed practice of aw?

Have SARCUonSs ever Desn entered JQAINSt you, of RAYE you ever been disgualified from
particigating i a case’

» Education

+ Residences and Local Law Enforcement

+ Employment

+ CRaracter and Fiiness

+» Ciwil | Criminal | Traffic



3.3.2.1. Edit Prior Applications for Admission Screen

On this screen, you will need to answer Yes or No on the radio buttons on the screen. Once you are
done, hit the Save Changes button.

Prior Applications For Admission Application: 1025

Back lo Overview  Save Changes ?

Prior A For A and Author To Practice Law

Have you ever submitied an application to register as a law student? ¥es Mo
Hawe you ever applied for admission on motien? Yes No
Have you ever applied for admission on motion by transterred UBE score? ¥eg Mo
Have you ever applied for admission by diploma privilege? YEs Mo
Have you ever registensd as a foreign legal consultant? Yes No
Hawe you ever registened as in-house counsel? g Mo
Hawe you submitied any other applications? Yes No
Bar Assoeidtion Membership

Attonmney Conduct
Hawe you ever been disbamed, ce regrin ordi as an attorney ? Yes No
Have you ever been the subject of any eharges, complainis, or grievances concerming your condust Yeg N

a5 an anomey?

Hawe you ever been the subject of any charges, complaints, or grievances alleging that you engaged Yeg N
In the unauthorized practice of law?

Hawe sanctions ever been entered 2gainst you, or have you ever been disq from p
inacase?

F ) Yes No



Once your changes are saved, if you have answered Yes on a question and there are additional details
needed, a table will appear below the row and you will be able to click the Add button on the top right
of each table to have a popup appear to enter details.

Prior Applications For Admission Application; 1025
Back ta Crerview Save C'Iilge‘i

Prior Applications For Admissions and Authorizations To Practice Law
Have you ever submitted an application to register a5 a law student? & g

Have yau ever applied for admission an metien? ®ves U No Add ?

g

Have you ever applied for admission on motion by transferred UBE score? Yes # No
Have you ever applied for admission by diploma privilege? Yies Mo
Have you ever registered as a foreign legal Hant? g Ne
Have you ever registered as in-house counsel? Yes N
Have you s any other apg 157 g No

| |
i

Attamey Conduet

Have you #ver been disbarmed, ce d, rep ded, or disg d as an atborney? = Yes Mo Add ?

Have you ever been the subject of any charges, complaints, of grievances concerming your eonduct Yes  #® No
2% an attormey?

Have you ever been the subject of any charges, complaints, or grievances alleging that you engaged © ves  No
in the unauthorized practice of law?

Hawe sanctions ever been antened 3gainst you, or have ¥ou ever bean disq 1 tram s Mo
inacase?



3.3.2.1.1. Prior Application Popup

If you have selected Add or Edit for one of the tables under the Prior Applications for Admission section
you will see this popup. Enter information needed and Save.

Jurisdiction
Application Date

Exam Date

Admitted Az

Reason Not Admitted

Date Admitted
Bar Number

Explanation

Save Cancel

Once you hit the Save button the popup will close and the row will appear under the appropriate table.

Prior Applications For Admissions and Authorizations To Practice Law

Hawve you ever submitted an application to register as a law student? ® Wes o
Have you ever applied for admission on motion? ® Yes o Aad
Geonia oA ikl i} D501 (=] R

Have you ever applied for admission on motion by transferred UBE score? Yes @ o



3.3.2.1.2. Bar Association Membership Popup

If you select the Add button or Edit icon for the table under the Bar Association Membership section,
the Bar Association Membership popup will appear. Enter information needed and Save.

Email

From Date

To Date Leava bilank for gurrand

Save Cancel

Once you hit the Save button the popup will close and the row will be added to the table with the
information you just entered.

Bar Association Membership

[

[ A |
| Asocsendame A Ema  Fomow  Tow

Tegl Mams 222 Test Ave, Amvytown, ME, 55555 tesiemaiBemal com oot 0501 a1



3.3.2.1.3. Attorney Conduct Popup

If you select the Add button or Edit icon for any of the tables under the Attorney Conduct section, the
Attorney Conduct popup will appear. Enter information needed and Save.

Disciplinary Agency

Agency
Address

Date

Case Number

Action Taken
Final Disposition

Explanation

Saye Cancel




On this popup, when you select the Disciplinary Agency, the Agency and Address will be automatically
filled out for you.

Disciplinary AQeNCY |~ .0

ARENCY |mye of Aomey Reguiation Coumsel

Address .,

X Broadwary Sie 500

Deate

Case Number
Action Taken
Final Disposition

Explanation

Once the Save button has been selected in the popup, the popup will close and a row will be added to
the associated table with the new information.

Attorney Conduct
Have you ever been disbarred, censured, repnmanded, of disgualified a3 an attorney ? & Yeg Mo | MUJ

Office of Altomery Regulabon Counsel 1300 Broadway Ste 500, Denver, C0, 30203 lest iest 01022000 K



3.3.2.2. Prior Applications for Admission Section — Completed

When the information is filled out and you go back to the overview, all the information will be displayed.
The Prior Applications for Admission section and Attorney Conduct section have too much information
to display all of it in once row so each record will be displayed within a grouping.

Prior Applications For Admission Edit

Prior Applications For AOmISSIoNS and Authorizatons To Practice Law
Have you ever submitted an application o register as a law student? Yes
Have you ever applied for admission on motion? Yes

Jurisdiction

Apply Date 0111
Admission Date 0501
Admitted As  les
Reason Not Admitted flest
Explanation fesl

Genrgia
Exam Date 02701
Bar Mumber lest

Hawve you ever applied for admission on motion by transferred UBE score? MHa
Have you ever applied for admission by diploma privilege? Ha
Hawe you ever registersd as a foreign legal consultant? Yes
Have you .'I'Il'“ﬂhuﬂd a% in-house counsel? N
HaVE you SUBMIMEd ARy other applicatiens? Yes
Bar Association Membership
The Bar 123 Bar Rd, Anytown, NE, 55555 emai@iesi com 05101
Attorney Conduct
Have you ever been disbarred, censured, reprimanded, or disqualified as an attorney? Yes
Ageney Office of Altormey Reguiation Counsel
Address 1300 Broadway Ste 500, Denver, CO. B0203
Case Number lest
Action  fest
Action Date O1022001
Final Disposition 1250
Explanation les!
Have you ever besn the ": ct of any cf [ laints, or g & concarming Yes

YOur conduct as an AtOmey?

Have you ever been the subject of any charges, comgpilaints, or grievances alleging that NG
you engaged in the unauthorized practice of law?



3.3.3. Education Section

To edit the section click on the Edit button on the top right.

Application: 1025
= General
» Frior Applications for Aomission

e

Law-Related Education

+ Residences and Local Law Enforcement
» Employment

» Character and Frness

= Civil | Criminal | Traffic

» Financial History

» Character Referances

» Applicant Documentation

Conkinie

3.3.3.1. Edit Education Screen

To add to the Education table or the Law-Related Education table, click on the Add button on the top
right of the table.

Education Information Application: 1025
Back to COvenview Save CHEI'FQES-

List complate information regarding your collegeiuniversity attendance, including instilutions at which you studied abroad, in reverse chronological order
= Report all law-related education and law schools in the "Law-Related Education™ section.
If the school's name has changed since your attendance, provide the currant and foamer names
Please indicate the degree received or enter "No Degree” if you ded not receive a degree
Multiple degrees receivad from the same school require separate entries, 8s do multiple penods of attendance (ether than those interrupted only by school
vacabons)

Education a0 < —
| copime  owse  Fedotmy  Pemdew  mMew

List complete nformation regarding your attendance at law schools/colleges/universities where you have siudied or are curmently studying law, including
institutions at which you studied abroad, in reverse chronological order
= [f the school's name has changed since your attendance, provide the currant and former names.
= Please indicate the degres receavad or expected 1o be racaived or enter "No Degresa” if you did not recene a degres
= Multiple degrees recenved from the same school require separate entries, as do multiple penods of altendance (other than those interrupted only by school
vacabons).

Law-Relatsd Education Add h



3.3.3.1.1. School Record Popup

If you select the Add button or Edit icon for the Education table, the School Record popup will appear.
Enter information needed and Save.

College/University Attendance and Discipline
List complete information regarding all college attendance

College: <o

Fieldis) of Study: e o
From

'ﬁ! TS Leava blank for cument schoo

Were you the subject of any formal or informal scholastic/ Yas No
disciplinary actions frem this institution?

If yes, provide a briel explanation Including any sanchions mposad by the institulions
Explanation:

espeanal

Save Camcel

Once the Save button is hit the popup will close and the row will be added on the main page.

University of Mebraska Hestory History o7 0501 FE



3.3.3.1.2. Law School Record Popup

If you select the Add button or Edit icon for the Law Related Education table, the Law School Record
popup will appear. Enter information needed and Save.

Law-related Education and Discipline
List compdete information regarding all law school altendance

Law School: les scha .

Degras: oo
From

To T Leave biank for cormond schoo

You must select a law school from the dropdown. Once a law school is selected, the address information
will pre-populate below it. Verify the information is correct and enter the rest of the information.

Law-related Education and Discipline
List complete information regarding all law schood attendance

Law School: | Boston University v
785 Commaonmwaalth Avenuse, Boston, MA, 2215

Degrea: oo

Fram

To 3, Loave biank for corment school




Once Save has been hit, the popup will close and the new record will show in the table on the main
page.

Law-Related Education Add

Boston Coliege test 0104 1208 £x

3.3.3.2. Education Section — Completed

The Education and Law-Related Education records contain too much information to display on one row
so each record will show in a different grouping.

Application: 1008
* General

+ Prior Appli 18 far Admi

Coliege Mame  Lniversity of Hetraska
Address 111 Colege Ave, Amyiown, NE, 55555
Degree Histary
Fledd of Study History
From GT Ta
Disciplinary Action  No
Explanation

Law School Boslon Colege
Address B85 Centre Strest. Newlon, MA 2450
Degree fost
From 01/04 To 1208

» Residences and Local Law Enforcement
» Employment

» Character and Fiiness

» Civil | Griminal | Traffic

» Finaneial Histery

* Character References

» Applicant Documentation



3.3.4. Residences and Local Law Enforcement Overview

To edit information in this section, select the Edit button on the top right.

Application: 1025
= Ganeral

& Prior A

L

= Education

Addresses Ean h

+ Emplayment
+ Character and Fitness
» Civil | Crminal | Traffic
» Financial History

» Character References

= Applicant Documentation

Contnpe

3.3.4.1. Edit Residence Information Screen
To add to the Addresses table, click the Add button on the top right of the table.

Residence Information Application: 1026
Back o Owvenview Save C-hﬂm}E'S

List every parmanent of lempasary physical address where you have resided for a penod of one more of longer in reversa chronalogical order
« I you have submitted an application lor bar admession of 1o pre-regester as a law student with a bar admitting avthodty, or have bean admitled, beensed, or
authonzed to practcs law, provida your residency informaton for the (a5t teh years of sinta you ware first admimad, hcensaed, of guthonzed 1o prachice law
whichever pariod of time |5 longer.
« [f the previous calegory does not apply to you, provide your residency informalion for the |ast fen years or since age 18, whichever period of time is
longer.

Addresses Add h



3.3.4.1.1. Address Popup

If you select the Add button or Edit icon for the Address table, the Address popup will appear. Enter
information needed and Save.

Address/P.O, Box

County counly

From mmsy To mmiyy Laave blank for currer addrass

if 3 ar mose months ad this address, complate the mfcrmaton for ocal law enforcemend

Once you hit the Save button, the new record will appear as a row in the table on the main screen.

Residence Information Application: 1025
Back to Overview  Save Changes
List ewary parmanant ar lampaosary physical addrass whare you have resided for a peniod of one mare or longer in réverse chronological order
= ['you have submitted an application for bar admession of 10 pre-register a5 a law student with a bar admitting authonty, of have been admilted, beensed or
authonzed 1o practce law, provide your residency information for the 1ast ten years of since you wera first admitted, licensed, or authonzed to practice law,
whichever period of time Is longer.

« [f the previous category does not apply to you, provide your residency information for the last ten yvears of since age 18, whichever period of time is
longer.

Addresses | Add

F33 My Sireet, Amnytown, NE, 55555 Ky County ueling | D505 £ R



3.3.4.2. Residences and Local Law Enforcement Section — Completed

The address records contain too much information to fit it on one row so on the overview each record
will display in a separate section.

* Ganeral
* Prior Apphications for Admission

» Edueation

Application: 1025

Addresses

Address

From

County

Law Enforcemant Name
Law Enforcement Address
Law Enforcement Email

» Employment

» Character and Finess
» Sivil | Criminal | Traffic
» Financial History

» Character References

* Applicant Documentation

Conganis

Ean

333 My Strasl Anytown, NE, 55555

2o To 0505
My Coounty

ArrviowT Police

444 Polce Ln, Anytown, NE. 55555

lrwiEemail cam



3.3.5. Employment Section

To edit the Employment Section select the Edit button on the top right.

Application: 1025
¥ Ganeral
¢ Prior Apphications for Admissken
+ Education

» Residences and Local Law Enforcement

£ < —

Employment Hestary

Employment Discipling

Hawe you ever been terminated, suspended. disciplined, laid off, or permitted to resign in liew of termination from any job?
Judicial Office

Have you ever held judicial office?

Milrtary Service

Hawe you ever been a member of the armed forces of the United States, its reserve companents, or the National Guard?
Licenses

Have you ever applied for a license or held a license for a business, trade, or profession other than as an attorney-at-law?
Have you aver been denied a license of had a license revoked for a business, trade, of profession?

» Character and Frness
» Ciwil | Crimimal | Traffic
¢ Financial History

* Character References

+ Applicant Documentation

b



3.3.5.1. Edit Employment Screen

Answer Yes or No to the question on this screen, and then make sure you select the Save Changes
button. To add to any of the tables displayed, click the Add button on the top right of the associated
table.

Employment Application: 1025

Backto Overview | Save Changes &
Employment History

List your employment and unemployment information for the last ten years or since you were first admitied, licensed, or authonzed to practice law, whichever
penod of tme is longer. If you have not been admitted, licensed, or authorized to practice law, please provide this information for the last ten years or since age
18, whichever penod of ime is shorter

Employment encompassas all par-tme and full-time employment, mcleding sell-employment, extamships, mternships (paid and unpasd), clerkships, maitany
service, volunteer work, and temporary employment. Provide a descriplion of your activities for any unemployment period of more than three monihs (e.g.,
attending law school, studying for the bar examination, seeking employment, elc )

|
|
T

Have you ever Deen terminated, suspended, disCiplingd, 1ald off, or permitted 1o resign In lieu of termination rom any job? (If the empIcyment was not ¥es O Mo
previously listed, please add it to the “"Employment History™ section above).
It yes, describe the circumstances in the space provided below:

enier explaination if you answered yes 1o the question above

Judicial Office

Hawe you ever held judicial office? Yes O Mo

Military Service

HI'I‘I'.'“ ever been 3 member of the armed forces of the United States, 1S reserve s:omponm. of the National Guard? ||']'l!. w“ emnter a recard into Y Mo
the tabie beiow for sach Service peried,

i

Have you ever applied for a license (even if the application was subsequently withdrawn) o held a license for a busi trade, of profession other than () ves Mo
a% an attorney-at-law?  yes, please enter a record into the table below for each license.

Hawe you ever been denied 3 license or had 3 license revoked for a b s, trade or profession? Yer  ® Ng

i



3.3.5.1.1. Employment History Popup

If you select Add or Edit on the table in the Employment History section, the Employment History popup
will appear. Enter information needed and Save.

Employer 1
Address

coumiry

Dates * iy MR Leave bilank for present
Position posiion
Reason for leaving =50 ol eaving

Unempioyed

Unemployed Actlvities coscripton of acivees
Verifying Reference (Optional)

Name nam:
Address




Once you hit the Save button, the popup will close and the new record will appear in the table in the
Employment History section.

Add

Big Slore Cashier 0545 DaoE s

3.3.5.1.2. Military Service Popup

If you hit the Add button or Edit icon on the table in the Military Service section, the Military Service
popup will appear. Enter any necessary information and Save. Remember to upload necessary
information to the Application Documentation tab of the overview.

Branch orinc
Rank
Serial Number
Dates From: oo Tt Leave blank fof present

Dwuty Station o
Address

Phaone oho

Emall email

Commanding Officer comrandng oflic

D4 you receive an honorable discharge?

Were you ever courn manialed?

Ware you aver awarded non-udicial punishment?
Were you allowed to resign im eu of 3 court martial?
Were you administratively discharged?

NOTE: Supplementary documents ane requined

Piease upload oopies of all your repons of separalion (2.0 Foam 214) The DD o 214 Bl you provicde must ndcale
Wour characser of sanvice

Save Cancel




Once the Save button is hit, the popup will close and new record will appear under the table in the
Military Service section.

Ay Frivate 0302 Fa

3.3.5.1.3. License Applied Popup

If you select the Add button or Edit on the table under the Licenses section, the License Applied Popup
will appear. Enter necessary information and Save.

License Type oo
Current Status
License Number «cnifoal
Issuing Authority =suing ashors

Dates Appllcation; ey Explration: mmuasyy Leave blank for present

Address

Cancel




Once the Save button is hit, the popup will close and the new record will appear under the table in the
Licenses section.

[

Accounbng 2m Impartant Accountanis D1 2003 0 R2008 L



3.3.5.2. Employment Section — Completed

The records added in the popups for the Employment screen include too much information to fit on one
line so each records that was created will appear in its own section.

¢ Residences and Local Law Enforcemant

Edit
Employment History
Employer Big Store

Address lest
From 0555 To 08/
Position  Cashier
Reason for Leaving

Empioyment Discipline

Have you ever been terminated. suspended, disciplingd, lald off, or permitted to resign in leu of termination from any job? No
Judicial Office

Have you ever held judicial office? Ne
Military Service

Have Fou ever been a member of the armed forces of the United $ates, i1s reserve compgonents, or the National Guard?

Branch Amy

Rank

Serial Number

From

Duty Station
Address

Fhone

Email

Commanding Officer

Privaie

23423

0302

Super Army Base

123 Army Rd, Anylown, WA 55555

Did you receive an honorable discharge?

Were you ever court martialed?

Were you ever awarded nonjudicial punishmant?

Were you allowed to résign in lieu of 3 court martial?

Ware you administratively discharged?

Licenses

Have you ever applied for & license or held & license for a business, trade, or profession other than as an sttorney-at-law?

Have you ever been d dal or had a li revoked for 8 business, rade, or profession?
License Type Accounting
Current Status Active
License Number 23111
Application Date 01/01/2003 Expirationfinactive Date 01/01/2009
Issuing Authority Imporiant Accountants
Address les!

Phone

M

N



3.3.6. Character and Fitness Overview

To edit this section, select the Edit button on the top right.

Application: 1025
v Gengral

+ Prior Applications for Admission
» Education
+ Residences and Local Law Enforcement

+ Empleyment

s S —|

Prefessional Conduct

Have you ever been suspended, censured, of otherwise reprimanded or disqualified as a member of another profession. or 3s a holder of
public offica?

Have you ever been the subject of any charges, complaints, or grisvances (formal or informal] concerning your conduct a5 a member of any
other profession. or as a holder of public office, including any naw pending?

Bonds

Has any surety on any bond on which you were the principal been required 1o pay any money on your beha?

Qther Conduct

Within the past five years. have you exhibited any conduct or behavior that could call into question your ability 1o practice law in 3 competent.
ethical, and professional manner?

Do you currently have any condition of impairment (Including, bt not limited 1o, substance abuse, alcohol abuse, of 3 mental, emotional, or
nervous disorder or condition] that in any way affects your ability to practice law in a competent, ethical, and professicnal manner?

Within the past five years. have you asserted any condition or impairment as a defenss, in mitigation, or as an explanation for your conduct in
the course of any Inquiry, any investigation, of any administrative of judicial proceeding by an educational instittion, government agency,
pratessional crganization, or licensing authonty; or in cennection with an employment disciplinary or termination procedure?

* Ciwil | Criminal / Traffic

» Financial Histary

¢ Character References

+ Applicant Decumentation

s



3.3.6.1. Edit Character and Fitness Screen

Make sure you select Yes or No for the radio button questions. For some questions, if the answer is Yes,
you will need to enter some additional information, such as an explanation, bond information, or
medical information. If you answer Yes to one of the questions in the Other Conduct section, you will
also need to use the link to download Form 7 and will need to go to the Applicant Documentation tab of
the overview. After you answer all the questions, make sure you hit the Save Changes button.

Character & Fitness Application: 1012
Back to Owerview | Save Changes h
Professional Conduct
Have you ever been suspended, censured, or otheryise reprimanded or disqualified a8 3 member of another profession, or 8 3 holder of public Yes No
office?

If yes, describe the circumstances in the space provided below:

Have you ever been the subject of any charges, complaints, or grievances (formal or informal) conceming your conduct as a member of any cther Yis Ho
professien, or as a holder of public office, including any now pending?

It yes, describe the circumstances in the space provided below:

Bonds

Has any surety on any bond on which you were the principal been required to pay any money on your behalf? s ]

If yes, provide the following:
Bond Holder

Address

Bong aAmount
Bond Date

Bond Reason



Within the past five years, have you exhibited any conduct or behavior that could call into question your ability 1o p law in a
professicnal manner?

ypetent, ethical, and

If yes, describe the circumstances in the space provided below:

enier @ detailed explanation if you9 ENSWered yes 1o e quesion abov

Do you cumently have any condition or impairment (including, but not limited 0, substance abuse, alcohod abuse, or 3 mental, smational, of nervous
disorder of condition) that in any way affects your ability to practice law in a competent, ethical, and professional manner?

It yes, provide the following:

Medical Name

slale v |op

countny v | |province [ophiona

It your answer is yes, are the limitations caused by your condition or impairment reduced or ameliorated because you receive ongoing treatment or
because you participate in 2 monitoring or support program?

If yes, please provide a descrption in the space provided and complets a Form 7 Medical Reference. Use the Applicant Documentation b to upload your
file,

e 1 L it x 1 T 1K e
Within the past five years_ have you asserted any condition or impairment a3 a defense, in mitigation, of as an explanation for your sonduct in the eourse
of any ingquiry, any ir gation, or any or judicial procesding by an sducational institution, government agency, professional ong

or licensing autharty; or in connection with an employmaent disciplinary or termination procedure?

It yes, describe the circumstances in the space provided Delow:

#MET 3 LneT ENpLETEnon i ViU SnsWeretd YES 1D INe queshon 3oy



3.3.6.2. Character and Fitness Overview — Completed

Application: 1025
+ Ganeral
» Prior Applications for Admission
» Education
¢ Residences and Local Law Enforcement
» Employment

Edii

Professional Canduct

Have you ever boen suspended, censured, of otherwise rep fed or disqualified as a member of another profession, or as a helder of e
public office?

Have you ever been the subject of any charges, complaints, or grievances (farmal or informal] cenceming your conduct as 2 member of any Mo
other profession, or as a holder of public office, including any now pending?
Bongs

Has any surety on any bond on which you were the principal been required to pay any money on your behall?

‘Other Conduet
Within the past five years, have you exhibited any condict or behavior that could call into question your ability 1o practice law in a competent,  'Yes
ethical, and professional manner?

Explanation: Made d poar choice

Do you currently have any condition or impairment (including, but not limited 1o, substance abuse, alcohol abuse, of 3 mental, emotional, or Mo
REVOUS disorder or condition] that in any way affects your ability 1o practice law in 2 competent, @thical, and professional manner?

Within the past five years, have you asserted any condition or impairment as a defense, in mitigation, or as an sxplanation fior your conductin -~ Mo
the course of any inquiry, any investigation, or any administrative o judicial procesding by an educational institution, government agency,
prafessional organization, or licensing authority: or in connection with an employmaent disciplinary or termination procedure?

Ciwil | Criminal | Traffic



3.3.7. Civil / Criminal / Traffic Overview
To edit this section, hit the Edit button on the top right.

Application: 1025
» Ganeral

» Frior App
+ Education
» Residences and Local Law Enfofcement

» Employment
* Character and Finess

Civil | Criminal | Traffie o < —

Civil Actions.
Have you ever been a named party to any civil action?

Have you ever had 3 complaint or action (including, bul not limted to, allsgations of fraud, deceit,
misrepresentation, forgery. of malpractice) nftiaited against you in any administrative forum?

Criminal Actions

Have you ever been cited for, arresied for, charged with, of convicted of any vislation of any law other than a
case ihat was resclved in juvenile court?

Have you ever been cited for, arrested for, charged with, or convicted of any aleahal- of drug-related traffic
viclation other than a vielation that was resolved in juvenile court?

Traffic Violations

Have you ever been cited for, arrestad for, charge with, or cenvicted of any moving traffic violation during the
past ten years? (Do not include parking violations.)

» Financial History
& Character Refersnces

* Applcant Documentation

Conssniss



3.3.7.1. Edit Civil / Criminal / Traffic Screen

Select Yes or No to answer all the questions on the screen. If you enter Yes for any of the questions, you
will also need to use the link to download and fill out a form (form 3, form 5, or form 5T depending on
the question), and then upload that document to the Application Documentation tab. Once you have

answered all the questions, make sure you hit the Save Changes button.

Civil | Criminal ! Traffic

Civil Actions
Have you ever been 2 named party to any civil action?

I ves, complete farm 3 and uplaad it for aach incident o (he Application Documenlation ab Include copies of the amesting
BOENCY'S Meport, complaint, indiciment, citation, mfonmation disposition, semence, and the appeal, it any

Have you ever had 3 complaint or actien (inchuding, but not limited to, allegations of fraud, deceit, misreprasentation,
Torgery, or Malpractics) iNitaited 3g3iNst you in any SOMINEStrative forum?

If ves, complete form 2 and upload it for each incident to the Application Documentation tab. Include copies of the amesting
agency's reporl. complaint, indciment, citalion, nformation dispasition, sentence, and (he appeal, if any

Criminal Actions

Have you #ver been cited for, arrested for, charged with, or convicted of any vislation of any law other than a case that
Was resolved in juvenile coun?

Ifwes, complele farm 5 and upload i for each incidend 10 he Application Dacumentation lab Incude Copies of The amesling
agency's report. complaint, indiciment, citation, information dispasition, senmence, and the appeal, it any

Have you ever been cited for, arresied for, charged with, or convicted of any alcohol- or drug-related traffic viglation
other than a viclation that was resolved in juvenile court?

If yes, complebe form 5 and uplead it for each incident o the Application Documeniation &b Include Coples. of the amesting
agency's report. complaind, indiciment, citation, mfommation disposilion, senfence, and [he appeal, i any

Traffic Violations

Have you ever been cited for, arrested for, charge with, or convicted of any moving traffic viclation during the past ten
years? (Do not include parking viclations.)

If ves, complebe form 5T and upload it for each nckent o the Application Documentation @b, Include copies of the amesting
agency's reporl. complaint, indicmend, citation, mfonmation dispasilion, semence, and (he appeal, if any

Yes

Yes

Yes

Mo

Mo

Mo

Mo

Application: 1025

Back to Overview  Save Changes h



3.3.7.2. Civil / Criminal / Traffic Overview — Completed

Application: 1025
» General
» Prior Applications for Agmission
» Education
» Residences and Local Law Enforcement
» Employmant
» Character and Fitness

Clvil | Criminal | Traffie Eail

Civil Actions
Have you ever been a named party to any civil action? Ko

Have you ever had a complaint ar actien (including, but not limited to, allegations of fraud, decsit, o
misrepresentation, forgery, or malpractics) mitiaited ag you in any adr ve forum?

Criminal Actions

Have you sver besn cited for, arrested for, charged with, or convicted of any vielation of any law other than a Ma
case that was mesclved n juvenile courl?

Have you ever been cited for, arrested for, charged with, or convicted of any alcohal- of drug-related traffic Mo
violation other than a viclation that was resolved in juvenile court?

Traftic Vislations

Have you ever been cibed for, armested for, charge with, of convicted of any moving traffic violation during the Ko
past tan years? (Do not Include parking vislations.)

» Financial History
¥ Character References

* Applicant Documentation

Cantinue



3.3.8. Financial History Overview
To edit this section, select the Edit button on the top right.
Application: 1028

» General

¢ Prior App for A

+ Education
+ Residences and Local Law Enforcement
+ Employment

+ Character and Fiiness

» Civil | Criminal | Traffic

ey ——
o < —

Have you ever had a credit card or charge account revoked?

Have you ever defaulted on any student loans?

Have you ever defaulted on any other debt?

Have you ever had debts of 3500 or mare that have been more than 50 days past due within the past three years?
Are there any additional debts not reported in previous debt questions that were not discharged in bankruptoy ?

Bankruptcy

Have you ever filed a petition for bankruptey?

+ Character References

+ Applicant Documentation

Coninie



3.3.8.1. Edit Financial History Screen

Answer Yes or No to all the necessary question. Once all the questions are answered, make sure you hit
the Save Changes button. If you answer Yes to the Credit/Charge Account Debt question, the Student
Loan Debt question, the Other Debt question, or the Past Due Debt question, select the Add button for
the associated table to enter the necessary information.

Fimancial History Application; 1025

Back to Cverview | Save Changes h

Cradit'Charge Account Debt
Have you ever had a credit of charge account revoked? Yes 0 No
It yes, please add an entry into the table below,

|
g
1

Have you ever defaulted on any student I6ans? © ves ' Mo
It yes, please add an entry into the table below.

i

Have you ever defaulted on any cther debt? Yes O Mo
If yes, please add an entry into the table below,

i

Past Due Debt

Have you had any debts of $500 or more that have been more than $0 days past due within the past three years? Yeg NG
It yes, please add an enftry into the table below,

E

E

E |
f

Are there any additional debts not reparted in previous debt questions that were not discharged in Bankruptey? ) ves Ha
It yes, please add an entry into the table below.



3.3.8.1.1. Debt Popup

If Add or Edit is hit under any of the sections on the previous screen, the Debt Account popup will
appear. The popup title and description will be pre-populated based on which section’s table you select
Add or Edit from. Enter necessary information and Save.

Description Charge Account
Account Number
Original Amount
Current Balance
Date of Last Payment

Creditor

Address

Phone |
Current Status

Explanation

Once Save is hit, the popup will close and the new record will display under the associated table.

[ s |

2M3233333333 Discover S00.0 200.0 R



3.3.8.2. Financial History Overview — Completed

The information entered on the popups on the edit financial history screen contain too much
information to display on one line, so each record will display in its own section.

Application: 1025
» Ganeral
» Prior Applications for Admission
+ Education
» Residences and Local Law Enforcement
+ Employment
v Character and FRN&ss

» Civil | Criminal | Traffic

Edit
Debis
Have you ever had a credit card or charge account revoked? Yes

Description Charge Accoun!
Account Mumbar 2343333333333
Qriginal Amgunt of Debt 2000
Current Balance 2000
Ceate of Last Payment 01012001
Creditor Descower
Address 233 Decover 51 Armyiown, CA, 55555

Phone S5355G5000

Current Status
Explanation
Have you ever defaulted on any student loans? Mo
Have you ever defaulied on any other debt? Mo
Have you ever had debts of $500 or more that have been more than 50 days past dus within the past three years? Mo
Are there any additional debits not repored in previous debt questions that wers not discharged in bankruptey ? Mo
Bankruptcy

Have you ever filed a petition for bankruptey? Ma



3.3.9. Character References Overview

To edit this section, select the Edit button on the top right.

Application: 1025
s General
* Prior Applications for Admission
+ Education
» Residences and Lacal Lyw Enforcement
+ Employment
* Character and Friness

» Civil § Criminal [ Traffic

* Financial Histary

Referances Edit h

+ Applicant Documentation

Contnus

3.3.9.1. Edit Character References Screen

To add character references, select the Add button on the top right of the table.

Character References Application: 1025
Back to Owerview Save Changes

Provide complate mformation for at least six raferences
= 115 praferabls that these relerences have Known you for & minimam of thres years
+ You are encouraged 1o include references from mone than one locality whers you have ved duning the kst 1en years
« Do not list yourself, anyone who is related 10 you by blood or mamiage, or anyone who resides at your curment residential address
= Do not use employment contacts used earlier in this application
= Do not use the same contacts who are providing your "Moral Character Affidanits®
= [fyou provide a business address please include the names of both the reference and the business

" < —
=N =" =" =T ="



3.3.9.1.1. Reference Popup

When Add or Edit is hit for the reference table, the Reference popup will appear. Enter necessary
information and Save.

Hame

Occupation

Business Name
Address

Save Cancel

Once Save is hit, the popup will close and new record will appear under the table.

Character References Application: 1025
Back o Crverview Save Enanges

Provide comiplate mformation for at least six referances

It is preferable thal these raferences have Known you for 8 mimimom of thres yaars

You are encouraged 10 include references from more than one loc ality whare you have Ined duning the iast en years

Do not st yourself, anyone who is related to you by blood or marmiage, or anyone who resides at your current residential address
Do not use employment contacts used earlier in this application

Do not use the same contacts who are providing your “Woral Character Affidavits"

IF you provide a business address please include the names of both the reference and the business.

.

Joe Boss 5555555555 fee@emall.com 15 SR



3.3.9.2. Character References Overview — Completed

The references information contain too much information to display on one line so each record will
display in their own section.

Application: 1026
» Genaral
* Prior Applications for Admission
» Education
» Residences and Local Law Enforcement
+ Employment
» Character and Frness

& Ciwil  Criminal | Traffie

» Financial Histary
References Eiit

Name Joe Boss
Occupation
Busingss Name
Address 237 My Street, Anylown, NE, 53555
Phone 5555555555
Emadl  josgflemail com
Years Known 15

» Applicant Documentation

3.3.10. Applicant Documentation Overview

To edit this section, select the Edit button on the top right.

Application: 1026
» General
s Prior App for &

» Education

» Residences and Local Law Enforcement
* Employment

» Character and Friness

» Civil ! Criminal | Trarmc

» Financial History

» Character Referances

Confnse



3.3.10.1. Edit Applicant Documentation Screen

On some of the previous applications, if you enter Yes to specific questions, you will also need to
download a form, fill it out, and add it in this section. To add a document, select the Add button on the
right of the table.

Applicant Documentation Application: 1025
Back o Overview Save Changes

* —
e T e s [ e[

Please click 1he add button to upload all required documeantation

3.3.10.1.1. Upload Document Popup

If you hit the Add button the Upload Document popup will appear. Select the attachment type and
select the Choose File button to go select the file from the local machine. Make sure the file does not
exceed 10 MB. Once this is complete hit Save.

MOTE: Files cannot exceed 10 ME in size
Attachment Type aiachmen: ype

File to upload | Choosa File Mo fike chosen

Once the Save button is hit, the popup will close and the document will appear in the table. This screen
does not provide an edit option for added documents, if you need to make a change you will need to
delete the document and add it again.

Applicant Documentation Application: 1025
Backto Overview  Save Changes

2]
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lakebemidjipal Other test file oazzomT X

Pleasa click the add bution to upload all raquired documentation



3.3.10.2. Applicant Documentation Overview - Complete

Application: 1025
» General

= Prior Applications for Admissicn

+ Education

» Residences and Local Law Enforcement
» Employment

¥ Gharacter and Fimess

» Ciwil ! Crimimal [ Trathic

+ Financial Higtory
» Character References

Eqit

akedemici pof Crthar lesi fie fa22mT

Continus

3.4. Application Payment

Once you have entered all the information necessary for your application, click the continue button at
the bottom of the Application Overview page.

Application: 10256

» Residences and Local Law Enforcement
» Employment

» Character and Finess

» Tl ! Crimimal | Trare

v Financial History
» Character References

Edit

akebemici paf Other lest e 22017

Contsise —



If you click the Continue button on the Application Overview screen and you are redirected to the
General Information screen that means you have not filled out the Applicant Type Category. Set this
value, select Save Changes, select Back to Overview, and try selecting Continue again.

Nebraska Supreme Court Attorney Services Division

Admissions  Home  View

General Information Application: 1025
Backto Overveny | Save Changers

Name .,

Gender © Male  ® Female
Dats of Birth __

Place of Birth
Citizenship
Soclal Security Number
Contact Information
[, | ——
Confirm Email .
Home/Mobile ¢ Work

Address |, .

Hebrasia

Address Type = Resdence ' Business

Applicant Type

Category _,
NCBE Number

MPRE Score

3.4.1. Calculate Payment

The next screen will consist of 1-5 question you will need to answer to be able to calculate the payment.
Based on your answer(s) to the question, other questions will appear if necessary. Once you have
answered all the questions you need to, the Calculate Payment button will become enabled.

Calculate Payment Application; 1025

1. Are you applying for admission "on motion™ or by sxam? On Motion By Exam

Calculate Fayment Application; 1025
1. Are you applying for admission "on metion™ or by exam? On Motion & By Exam

215 this your first application for admission to Nebraska? Yes = No

3. Did you take the Nebraska bar exam immediately preceding the exam for which you are applying? Yes ™ No

4. Did you take the Nebraska bar exam at a prior administration that was not immediately preceding this exam? ®Yes Mo

&. Do you have an MPRE score of 82 or higher as of today, that was first published no more than 3 years ago? Yes Mo

—



3.4.2. Make Payment

Once you hit the Calculate Payment button, your Payment Due will appear at the bottom of the page.
Select the Make Payment button.

Caleulate Payment Application; 1025
1. Are you applying for admission “on moton™ or DY sxam? On Motion '™ By Exam

2 |5 this your first application for admistion to Nebraska? Yo W N

3. Did you take the Mebraska bar exam immediately preceding the exam for which you are applying? Yes '@ No

4. Did you take the Nebraska Dar exam at a prior administration that was not immediately preceding this exam? ® Yes

& Do you have an MPRE score of 85 or higher as of today, that was first published no mone than 3 years ago? Yes NG

Payment Due: $615.00

Make Paymen ?

3.4.3. Calling US Bank Portal

The Nebraska Admissions Application uses USBank to process credit card payments. You will very quickly
see this screen while we make the call to USBank to continue with the payment. Once it is ready, the
USBank Payment Portal will appear.

Make Payment Application; 1025

Processing payment information, you will be
redirected to the EPayment site shortly.

Do not refresh this page or press the 'Back’ button.

USBANK SCREENSHOTS HERE

Once a payment has been processed successfully, it will appear in the Payment History screen which can
be accessed via the navigation bar along the top by going to View -> Payments. Please allow several
minutes for this to process successfully once you have stepped through the USBank payment screen and
made your payment.



4. Payment History

Once a payment has been made, you can select Payment History from the menu navigation under View -
> Payments. Please allow a few minutes for your payment to appear once you have entered you credit
card information and submitted it via US Bank.

Payment History

1011 1025

By Exam Application Fes 05220 T 02:56 PM SE15.00 FAKEPAYMENT

5. Exam Scores

Once the exam scores are available, you will receive an email letting you know that your exam score is
ready. Log into the application again and go to the Exam Scores screen via the navigation bar by going to
View -> Exams.

Exam Scores



